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Uvod u razdvajanje frekvencija u Photoshopu
• Odvajanje frekvencije se koristi za retuširanje kože uz očuvanje teksture

• Za razliku od osnovnih alata za retuširanje, odvaja detalje slike od boje

• Kreiranje dva sloja: visoke frekvencije (tekstura) i niske frekvencije (boja 

/ ton)

• Ranije korišćeni alati: Spot Healing Brush Tool, Remove Tool, Patch Tool, itd

• Čišćenje mrlja destruktivno na novom sloju

• Korišćenje alata Spot Healing Brush za male mrlje; Patch ili Remove Tool za 

veće

• Spajanje očišćenih slojeva pomoću prečice: Ctrl + Shift + Alt + E (pobeda) ili 

Cmd + Shift + Opt + E (Mac)



Kreiranje frekventnih slojeva
• Dupliranje spojenog sloja dva puta: označavanje ih Visoka frekvencija i 

Niska frekvencija

• Rad na sloju niske frekvencije: nanošenje Gaussovog zamućenja za 

uklanjanje tekstura

• Podešavanje zamućenja dok teksture kože jednostavno nestanu (6 pk 

radijus)

• Visoke frekvencije sloj snima teksture izvađene iz zamagljene verzije

• Korišćenje Appli Image da oduzme teksturu od niske frekvencije

• Primeni podešavanja slike za 8-bitni:

- Sloj: Niska frekvencija | Mešanje: Oduzimanje

- Skala: 2 | Ofset: 128 | Kanal: RGB

• Promena režima mešanja visoke frekvencije na linearnu svetlost



Korišćenje četke za mešanje
• Grupisanje slojeva visoke i niske frekvencije zajedno (Ctrl / Cmd + G)

• Rad samo na sloju niske frekvencije za mešanje tonova

• Korišćenje alata Mixer Brush Tool za prirodno mešanje tonova kože

• Podešavanja za mikser četkom:

- Clean Brush (omogućeno) | Automatsko čišćenje nakon svakog moždanog 

udara

- Mokro: 9% | Opterećenje: 75% | Mik: 90% | protok: 100%

• Slikanje u pravcu kontura lica (obrazi, vilica)

• Korišćenje manje četke za fine površine (ispod očiju, oko nosa)

• Izbegavanje gubitka teksture držeći poteze suptilne i usmerene



Konačni rezultati i razmatranja
• Prebacivanje pre / posle korišćenja Alt (Opcija) + Kliknite na rezervni sloj 

za poređenje

• Rezultat: glatki tonovi kože sa očuvanim detaljima na nivou pora

• Metoda radi na drugim oblastima kao što su teksture tela ili čak odeće

• Slike visoke rezolucije daju bolje ishode razdvajanja frekvencija

• Efikasan za profesionalno retuširanje kože sa kontrolom

• Uvek održavanje rezervnih kopija kako bi se kasnije omogućilo 

prilagođavanje

• Preporučuje se za napredne retuširanje izvan početnika alata



Napredno retuširanje lica pomoću Likuifi filtera
• Likuifi Filter je moćan Photoshop alat koji se koristi za detaljne 

modifikacije lica

• Pristup preko filtera > Likuifi nakon pretvaranja sloja slike u Smart Object

• Alat za likuidiranje Face-Avare automatski detektuje crte lica

• Uređivanje pojedinačnih delova: oči, nos, usta, oblik lica

• Oči: Podešavanje veličine, visine, širine i rotacije za svako oko posebno

• Nos: Izmena visine i širine da preoblikuje izgled

• Usta: Kontrolisanje osmeha, veličine usana, visine usta i širine

• Oblik lica: Promena čela, brade, vilice i ukupne širine lica



Radni tok i praktična upotreba
• Čuvanje prethodno korišćene slike kao JPEG pre početka 

(Ctrl / Cmd + Shift + S) i otvaranje kao novi dokument

• Pretvaranje sloja u Smart Object za nedestruktivno uređivanje

• Korišćenje prekidača za pregled za upoređivanje pre i posle promena

• U cilju suptilnih prilagođavanja za održavanje realnog retuširanja

• Prekomerna upotreba dovodi do neprirodnih ili preteranih rezultata

• Mršavljenje lica: smanjenje širine, povećanje visine čela

• Prilagođavanja vođena namerom: realizam vs. kreativna distorzija

• Eksperimentisanje sa funkcijama za učenje fleksibilnosti alata



Vežba 1
• Napredno retuširanje izolovanjem tekstura od tonova

• Cilj: poboljšanje slike sa teškim mrljama koristeći nedestruktivno uređivanje

• Počnite uvozom slike akni preko File > Open

• Otključavanje pozadinskog sloja i kreiranje novog praznog sloja za lečenje

• Koristite Spot Healing Brush Tool set za uzorkovanje svih slojeva

• Uklonite bubuljice, mrlje i mrlje sa lica, ramena i ruku

• Potvrdite rezultate prebacivanjem vidljivosti sloja (pre / posle provere)

• Merge vidljive slojeve sa Ctrl + Shift + Alt + E (Cmd + Shift + Opt + E na Mac)



Vežba 1
• Duplikat spojeni sloj dva puta: navedite jedan Niska frekvencija, drugi

Visoka frekvencija

• Nanesite Gaussian Blur na sloj niske frekvencije (podesite dok tekstura 

kože ne izbledi)

• Na sloju visoke frekvencije koristite Image > Apply Image sa:

- Sloj: Niska frekvencija

- Mešanje: Oduzimanje, Skala: 2, Ofset: 128, Kanal: RGB, Neprozirnost: 

100%

• Podesite režim mešanja sloja visoke frekvencije na linearnu svetlost

• Grupišite oba sloja za organizovano uređivanje (Ctrl / Cmd + G)

• Izaberite sloj niske frekvencije i izaberite Mikser Brush Tool

• Podešavanja četke za mikser: meka okrugla četka, čista četka, mokro: 9%, 

opterećenje: 5%, mešanje: 90%, protok: 100%



Vežba 1
• Boja u pravcu kontura lica; pažljivo pratite prirodne senke i naglaske kako 

biste izbegli izravnavanje crta lica

• Ponovo procenite snagu Gaussian Blur ili upotrebu miksera ako rezultat ne 

izgleda prirodno

• Neki detalji gubitak može doći; podesite sa krive ili nivoa ako je potrebno

• Dalje poboljšanje: primenite Dodge & Burn ili druga lokalna podešavanja

• Ponovo izaberite područja lica i primenite suptilne Gaussian Blur ili 

korekciju tona

• Smanjite neprozirnost podešavanja da biste održali prirodan izgled (34% 

neprozirnosti)

• Konačni rezultat pokazuje značajno poboljšanje uprkos izazovnom početnom 

stanju



Vežba 2
• Počnite spajanjem svih vidljivih slojeva koristeći Ctrl + Shift + Alt + E (Vin) 

ili

Cmd + Shift + Option + E (Mac)

• Pretvori spojeni sloj u Smart objekat za nedestruktivno uređivanje

• Pristupite Likuifi Filter iz menija Filter

• Koristite Face-Avare Likuifi Tool da biste precizno prilagodili crte lica

• Izmenite veličinu očiju da biste ispravili asimetriju i prilagodili rastojanje 

između očiju

• Smanjite intenzitet izraza lica spuštanjem osmeha i repozicioniranjem usana

• Smanjite strukturu lica i skratite čelo za proporcionalno usavršavanje

• Uporedite slike pre i posle da biste procenili promene u ravnoteži i izrazu 

lica



Napredna korekcija boja i Camera Rav
• Napredne korekcije boja i tehnike ocenjivanja u Photoshopu

• Primena  nivoa i krivih za podešavanje tonova i boja

• Korišćenje dodatka Camera Rav za nedestruktivne tokove rada u boji

• Tehnika za prenos ocenjivanja boja sa jedne slike na drugu

• Metode za dodavanje boje crno-belim slikama

• Istraživanje skrivenih alata i funkcija za ocenjivanje boja u Photoshopu

• Naglasak na profesionalnim, fleksibilnim pristupima poboljšanju estetike 

slike



Napredna upotreba nivoa u Photoshopu
• Podešavanje nivoa omogućava preciznu korekciju boja i tonski balans

• Histogram se deli na senke (levo), srednje tonove (srednji), naglašava 

(desno)

• Holding Alt / Option + Auto da otkrije različite algoritme za automatsko 

poboljšanje

• Izbor i čuvanje željenih algoritama kao podrazumevani

• Prilagođavanje senke, srednjeg tona i istaknutih boja kako bi se omogućilo 

kreativno ocenjivanje

• Color Picker Alati omogućavaju direktnu manipulaciju tonskih područja 

(crvene senke)

• Podešavanja kliping podesiti koliko detalja se zadržava ili gubi u tonskim 

ekstremima

• Mogućnost rada na RGB ili pojedinačnim R / G / B kanalima za finiju kontrolu



Više nivoa profesionalnih saveta
• Built-in preseta kao što su Povećanje kontrasta i Lighten Shadovs 

pojednostaviti ocenjivanje

• Bela, siva, i crna tačka selektori koji omogućavaju ručno korekciju balansa 

boja

• Držanje Alt/Option dok podešavate klizače da prikažete isečene 

(izgubljene) detalje

• Clipping indikatori pomažu u održavanju integriteta detalja slike tokom 

podešavanja

• Uzorkovanje bele površine pomoću alata Bela tačka za ispravljanje balansa 

bele boje na globalnom nivou

• Korišćenje Alt / Option + Auto za dalje podešavanje koje omogućava izbor 

metoda kao što su: Monohromatski kontrast, Poboljšanje kontrasta po 

kanalu, itd



Napredna upotreba krivih u Photoshopu
• Krive omogućavaju ciljano podešavanje senki (levo) i svetla (desno) preko 

krive tona

• Držite Alt (Option) dok podešavate klizače da biste otkrili upozorenja o 

klipingu, pomažući u očuvanju detalja

• Photoshop nudi opcije automatskog poboljšanja pod Alt / Option + Auto, 

uključujući prilagođavanja po kanalu i kontrastu zasnovana

• Preseti kao što su Negative, Cross Process, ili Darker daju kreativan izgled; 

rezultati se mogu pregledati uživo

• Krive i nivoi imaju slične osnovne funkcije

• Podešavanje pojedinačnih RGB kanala poboljšava kontrolu boja i tonski 

balans

• Većina podešavanja krive prati  oblik S-krive ili Z-krive, poboljšavajući 

kontrast ili stilizaciju



Ciljana kontrola boja i kombinovana podešavanja
• Ciljani alat za podešavanje (kliknite i prevucite na slici) menja određene 

tonove direktno na slici

• Omogućava preciznu kontrolu nad tonovima kože, pramenovima, senkama i 

intenzitetom boje

• Beli, sivi i crni uzorci omogućavaju brzo tonsko balansiranje slike

• Kombinovanje podešavanja nivoa i krivih poboljšava i globalni ton i tačnost 

boja

• Dodao Hue / Saturation sloj omogućava promene zasićenja na osnovu selekcije 

za suptilnu prefinjenost

• Vizuelno poređenje pre i posle pokazuje značajno poboljšanje u tonu i toplini

• Poslednji korak podrazumeva čuvanje željenih verzija i odbacivanje 

eksperimentalnih izmena



Uvod u Camera Raw –JPEG vs RAW
• JPEG slike: široko kompatibilne i jednostavne za korišćenje; kompresija i 

gubitak podataka utiču na kvalitet slike

• RAV slike: neobrađene datoteke preuzete direktno sa fotoaparata, 

zadržavajući pune podatke o slici

• RAV datoteke znatno veće veličine zbog očuvanih detalja i većeg kvaliteta

• Zumiranje RAV slika otkriva teksturu kože i fine detalje bez gubitka kvaliteta

• Isečena naglašava u RAV slikama često se može oporaviti tokom uređivanja

• JPEG slike gube detalje u preeksponiranim ili svetlim regionima (belci)

• Oporavak detalja u JPEG je ograničen ili nemoguće zbog prethodne kompresije

• RAV datoteke omogućavaju preciznu fleksibilnost naknadne obrade koja nije 

dostupna u JPEG-ovima



Rad sa RAV datotekama u Photoshopu
• Otvaranje RAV datoteke automatski pokreće Camera Rav modul

• Camera Rav je i dodatak i filter koji se koristi za uređivanje RAV i ne-RAV 

formata slika

• Podešavanje ekspozicije i naglašava u Camera Rav može vratiti skrivene 

podatke o slici

• JPEG formati obrađeni u Camera Rav pokazuju minimalno poboljšanje zbog 

izgubljenih informacija

• Camera Rav čuva metapodatke kamere, kao što su originalni balans bele boje i 

podešavanja snimanja

• Opcije balansa bele boje uključuju As Shot, Auto i druge izvedene iz kamere

• RAV slike zadržavaju punu vernost podešavanja fotoaparata za precizniju 

korekciju boja



Camera Raw –Podešavanje i osnovni alati
• Camera Rav plugin se prvenstveno koristi za korekciju boja, ali nudi mnoge 

druge funkcije za uređivanje

• Pristup podešavanjima > toku posla pre uređivanja za konfigurisanje:

- Prostor boja: Preporučena opcija je Adobe RGB (1998) za većinu zadataka

- Dubina bita: Korišćenje 16-bitnog za veći tonski opseg i fleksibilnost slike

• Prikaz  prikazuje žive preglede izmena primenjenih na sliku

• Osnovni alati uključuju:

- Zoom Tool: Kliknite-prevucite ili koristite Ctrl/Command + +/– za 

uvećanje/smanjivanje

- Pan (ruka) Alat: Držeći razmaknicu + prevucite za navigaciju uvećanu sliku

• Podešavanja na desnom panelu koriste klizače za podešavanje parametara 

slike kao što su:



Camera Raw –Podešavanja i upozorenja o klipovima
• Klizači se mogu resetovati pojedinačno dvostrukim klikom na svaki klizač

• Korišćenje dugmeta Reset to Default da resetujete sve izmene

• Clipping upozorenja pomoći da se identifikuje gubitak detalja u senkama ili 

highlights:

- Crveni prekrivač: Označite isečenje; Plavi prekrivač: Senka isecanje

- Omogućite / onemogućite upozorenja koristeći ikone gornje trake ili prečice:

 O - Prebaci osvetli upozorenje o isecanju

 U - Toggle shadow clipping upozorenje

• Primer: Povećanje crne boje otkriva isecanje senki; povećanje ekspozicije

pokazuje iseckanje svetla

• Vizuelni indikatori pomažu u balansiranju tonskog opsega i očuvanju detalja na 

slici



Camera Raw –Uređivanje i pregled interfejsa
• Automatsko podešavanje: Automatski primenjuje promene; ručna kontrola 

poželjna za preciznost

• Crno-bela opcija: Pretvaranje slike u monohromatsku uz omogućavanje 

podešavanja tona / boja

• HDR panel: Koristi se za HDR uređivanje; nije dostupno na JPEG ili kada 

koristite Camera Rav kao filter

• Edit: Panel za podešavanje jezgra

• obrezivanje, lečenje, maskiranje, crvene oči, snimak, preseta, podešavanja 

slike

• Izbor profila: Uključuje Adobe Color, Pejzaž, Portret, Živopisna; podešavanje 

na osnovu tipa slike

• Podešavanja svetla: Kontrolišite ekspoziciju, kontrast, istaknute delove, senke, 

bele i crne pomoću klizača



Camera Raw –Prilagođavanje boja i efekata
• Boja panela:

- Podešavanje temperature, nijanse, živosti i zasićenja

-Balans bele boje Alat se koristi za klik na neutralnu tačku za automatsku 

korekciju

• Efekti panela:

- Tekstura: Poboljšanje ili glatke fine detalje

- Jasnoća: Povećanje kontrasta srednjih tonova za oštrije detalje

- Dehaze: Smanjuje ili dodaje atmosfersku izmaglicu

- Vinjeta:

 Podešavanje intenziteta (bele do crne ivice)

 Kontrolisanje srednje tačke, zaobljenosti, perja i naglašavanja

- Zrno: Modifikovanje količine, veličine i hrapavosti za simulaciju teksture 



Camera Raw –Curves & Color Mixer
• Podešavanje krive: Modifikovanje osvetljenja i tame; kontrola tonskog opsega

• Tačka vs parametarska kriva: Tačka omogućava ručnu kontrolu naglasaka, 

senki, itd .; Parametarski nudi pojednostavljene klizače tonskog opsega

• Uređivanje specifično za kanal: Podešavanje crvenih, zelenih i plavih kanala 

pojedinačno za kreativne efekte

• Alat za krivu na slici: Direktna manipulacija slikom klikom i povlačenjem da 

biste osvetlili / zatamnili područja

• Zoom Controls: Korišćenje Alt / Option i točkić miša za zumiranje tokom 

uređivanja

• Color Mixer – Hue, Saturation, Luminance: Podešavanje specifičnih opsega 

boja kao što su crvene, narandžaste, žute nezavisno

• Ciljano podešavanje boja: Ručni izbor i podešavanje određenih boja unutar 

slike



Ocenjivanje boja, obrezivanje i pre / posle
• Panel za ocenjivanje boja: Primena tonova na srednje tonove, senke i 

naglašava za kinematografski izgled

• Opcije balansa i mešanja: Fino podešavanje kako tonovi boja međusobno 

deluju preko opsega osvetljenosti

• Detalji i optika Sekcije: Oštrenje slike ili primena optičke korekcije

• Panel za usjeve: Obrezivanje, rotiranje ili ispravljanje slike pomoću podesivih 

alata

• Zaključavanje odnosa aspekta: Održavanje fiksnih proporcija useva ili 

slobodno podešavanje dimenzija

• Unapred podešeno obrezivanje: Izbor iz unapred definisanih odnosa kao što su 

KSNUMKS: KSNUMKS ili puni kadar

• Rotacija i Flip Opcije: Rafiniranje kompozicije pomoću podešavanja 

orijentacije



Snimci u Camera Rav
• Snapshots Funkcija: Čuvanje različitih verzija ili "izgleda" slike u okviru istog 

Camera Rav datoteke

• Kreiranje snimaka: Korišćenje panela za snimanje za kreiranje i imenovanje 

svake verzije

• Višestruke varijante: Različito ocenjivanje boja, crno-bele izmene ili bilo koja 

podešavanja mogu se sačuvati kao zasebni snimci

• Trajno čuvanje: Svi snimci ostaju ugrađeni u datoteku slike čak i nakon 

zatvaranja i ponovnog otvaranja

• Fleksibilnost uređivanja: Prebacivanje između snimaka za poređenje ili dalju 

modifikaciju

• Izvoz Sposobnost: Izbor bilo verzije snimak za konačni izvoz ili dodatno 

uređivanje

• Efikasan radni tok: Nedestruktivno eksperimentisanje bez gubitka napretka



Alati za lečenje u Camera Rav
• Healing Tool Svrha: Uklanjanje malih mrlja ili nesavršenosti; slično Photoshop 

je lekovita četka

• Podešavanje zumiranja i četkice: Zumiranje i smanjenje veličine četkice za 

precizne korekcije

• Alati uključuju Healing, Content-Avare Remove, i Clone Tools za različite 

potrebe popravke

• Vizuelizacija izmena: Pritiskom na V / prebacivanje vidljivosti polje za 

potvrdu da biste videli pogođena područja

• Kontrole za podešavanje: Modifikovanje veličine četke, perja i neprozirnosti 

za bolje mešanje

• Reset and Refresh: Korišćenje dugmeta za resetovanje ili osvežavanje za 

alternativne korekcije prekrivača

• Ograničenje upotrebe: Efikasno za male mrlje, a ne za korekcije velikih 



Maskiranje u Camera Rav
• Maskiranje Svrha: Primena prilagođavanja na određene delove slike 

nedestruktivno

• Osnovni alati: uključuju predmet, nebo, pozadinu, objekat, četku, linearni 

gradijent i radijalni gradijent

• Selektivna podešavanja: Svaka maska izoluje područja, omogućavajući 

fokusirane izmene kao što su izlaganje ili promena boje

• Dodaj/oduzmi maske: Maske se mogu kombinovati ili dorađivati dodavanjem ili 

oduzimanjem selekcija

• Maskiranje uz pomoć AI: Alat People koristi AI za izolaciju delova tela kao što 

su usne, koža, kosa i još mnogo toga

• Pregled maske: Prebacivanje vidljivosti prekrivača da proveri maskirane oblasti 

pre primene izmena



Prefinjenost maski, pametni objekti i alat za crvene oči
• Smart Object Ekport: Otvaranje slike kao pametnog objekta da zadrži Camera 

Rav postavke i omogući buduće izmene

• Flat Image Ekport: Otvaranje slike kao redovne rasterizovane datoteke sa 

nepovratnim izmenama

• Snapshot Integracija: Nakon maskiranja, prethodno sačuvane snimke mogu se 

opozvati za kontrolu verzija

• Alat za crvene oči: Uklanjanje defekata crvenih očiju klikom na zahvaćeno 

područje

• Podešavanja crvenih očiju: Modifikovanje veličine učenika i tame za optimalnu 

korekciju

• Nedestruktivni radni proces: Kombinovanje maski, snimaka i izvoza pametnih 

objekata kako bi se očuvala fleksibilnost uređivanja

• Finaliziranje podešavanja: Potvrđivanje izmena preko panela za uređivanje da 



Vežba 3
• Otvorite RAV sliku u Camera Rav i podesite prostor boja na Adobe RGB (1998) i 

dubinu na 16-bitni za bolju vernost boja

• Koristite beli balans alat za uzorkovanje neutralnu tačku i ispravnu 

temperaturu / nijansu

• Podesite ekspoziciju, kontrast, Highlights, senke, bele i crne da biste poboljšali 

tonski opseg

• Povećajte Vibrance malo; izbegavajte jaku zasićenost u ovoj fazi

• Nanesite podešavanje krive za ciljanu tonsku korekciju

• Koristite mikser boja ili ciljani alat za fino podešavanje određenih opsega boja

• U efektima, pojačajte teksturu i jasnoću za oštrije detalje (brada); nanesite 

lagano uklanjanje izmaglice i suptilnu vinjetu

• Koristite ocenjivanje boja: dodajte plave tonove senkama, ostavite Highlights 

neutralan; podesite mešanje ~ KSNUMKS%, podesite ravnotežu malo za hladnije 



Vežba 3
• Dodajte distorziju objektiva suptilno za stilski efekat

• Koristite alat za ispravljanje unutar panela za usjeve da biste izravnali položaj 

subjekta

• Healing Step kasnije u Photoshopu, a ne u Camera Rav

• Nanesite Gradient Mask da osvetlite tamnu stranu lica sa manjim povećanjem 

senke i ekspozicije

• Polovni Brush Mask na području vrata da suptilno podigne osvetljenost senke i 

otkrije detalje

• Stalno koristite pre / posle Toggle & Side-bi-Side Previev da biste procenili 

suptilna poboljšanja i osigurali prirodan izgled

• Izvoz u Photoshop kao Smart objekat za očuvanje fleksibilnosti

• Napravite rasterizovani sloj za uklanjanje mrlja pomoću Spot Healing Brush 

Tool



Vežba 3
• Dupli slojevi za pripremu za razdvajanje frekvencije (ne izbegavanje / 

spaljivanje); Organizujte se u grupe

• Na donjem sloju nanesite Gaussian Blur (oko 7,2) da biste uklonili detalje 

visoke frekvencije, ali sačuvali strukturu lica

• Na gornjem sloju koristite Primeni sliku sa:

- Mešanje: Dodavanje, Skala: 2, Obrnuto: Uključeno (za 16-bitne slike)

- Ciljano kopiranje u sloj i RGB kanal za precizno mapiranje tekstura

• Podesite gornji sloj na režim linearnog mešanja svetlosti i grupišite oba sloja 

kao grupu za razdvajanje frekvencija

• Koristite mikser Brush Tool na zamagljenom sloju:

- Podešavanja: Mokro 9%, Opterećenje 75%, Mik 90%, protok 100%, Uzorak Svi 

slojevi: Isključeno

- Boja u pravcu kontura i teksture kože



Vežba 3
• Koristite uvećani prikaz dok mešate za prirodne rezultate; Fokusirajte se na 

konture lica i područja ispod očiju

• Kreirajte spojeni sloj (Ctrl / Cmd + Shift + Alt / Option + E), a zatim dodajte 

sloj za podešavanje nijanse / zasićenja:

- Smanjite zasićenje na -88, a zatim koristite meku masku četkicom za 

selektivno desaturiranje crvenila očiju

• Duplikat spojenog sloja (Ctrl / Cmd + G) pre primene izbegavanja i spaljivanja 

za nedestruktivno uređivanje

• Počnite sa Burn Tool:

- Cilj: Senke, Ekspozicija: ~ 26%

- Koristite minimalne poteze kako biste poboljšali konture lica i produbili 

odabrane oblasti



Vežba 3
• Prebacite se na Dodge Tool:

- Cilj: Ističe, Izloženost: ~ 10%

- Nanesite na područja kojima je potreban lagani naglasak kako biste 

oblikovali naglaske na licu

• Pažljivo uključite pre / posle pogleda da biste procenili poboljšanja; podesite 

neprozirnost za prirodnu završnu obradu

• Nanesite sloj za podešavanje boja za kreativno ocenjivanje boja:

- Pregledajte LUT koristeći da pronađete izbledela ton koji odgovara 

portretnom raspoloženju

• Eksperimentišite sa načinima mešanja (boja, osvetljenost, nijansa) da biste 

testirali suptilne efekte

• Obrnite masku za podešavanje (Ctrl / Cmd + I) i selektivno obojite predmet da 

lokalizujete efekat



Prenos ocenjivanja boja –uzorkovanje i priprema
• Otvaranje izmenjenu sliku iz prethodne sesije i primenom sloja za podešavanje 

ekspozicije

• Blago povećanje osvetljenosti za bolji osnovni izgled pre čuvanja slike kao JPEG

• Otvaranje ciljne slike (iz koje će se kopirati ocenjivanje boja)

• Učitavanje izmenjenu sliku u istom radnom prostoru kao i drugi sloj

• Korišćenje pravougaonog Markuee Tool da biste izabrali reprezentativnu oblast 

kože iz referentne slike

• Dupliranje selekcije i pomeranje na ciljnu sliku (Move Tool)

• Korišćenje alata Eiedropper Tool za uzorkovanje tri tonske zone: naglaske, 

srednje tonove, senke

• Korišćenjem alata za četkicu da postavite svaki uzorkovani ton na referentnu 

sliku za kasniju upotrebu u usklađivanju boja



Prenos ocenjivanja boja –Prenos i podešavanje
• Dodavanje sloja za podešavanje krivih na ciljnu sliku i obezbeđivanje ikone krive 

(ne maska) je izabrana

• Dvaput kliknite na kapaljku za belu tačku i dodelite uzorkovanu boju za isticanje 

iz reference

• Ponavljanje za sivu tačku i crnu tačku koristeći uzorke srednjeg tona i senke

• Klikom na odgovarajuće highlight, midtone, i senke oblasti na ciljnoj slici da 

primenite uzorkovane tonove

• Fino podešavanje krive za podešavanje kontrasta ili poboljšanje vizuelne 

privlačnosti ako je potrebno

• Maskiranje područja očiju pomoću meke četke za očuvanje prirodne beline

• Dodavanje opcioni drugi sloj krive za manje kontrasta ili ekspozicije 

prefinjenosti

• Prebacivanje vidljivosti slojeva za podešavanje da uporedi pre i posle efekat 



Dodavanje boje crno-belim slikama

• Bojenje crno-belih slika zahteva referentnu fotografiju sa sličnim 

osvetljenjem i tonova kože

• Referentna slika pomaže u repliciranju realnih vrednosti boja na ciljnoj slici

• Obe slike treba otvoriti u Photoshopu za upoređivanje rame uz rame

• Prevlačenje referentne slike na crno-belo platno slike

• Kreiranje paletu boja pomoću uzorkovanih naglasaka, srednjih tonova i senki

• Korišćenje eliptičnog alata za odabir reprezentativnih područja za svaki ton

• Usrednjavanje svake izabrane oblasti pomoću komande Filter > Blur > Average 

• Ova metoda pojednostavljuje složene tonske oblasti u pojedinačne 

reprezentativne boje



Kreiranje i primena gradijentne mape

• Kreiranje novog sloja za izgradnju paletu boja od uzorkovanih tona područja

• Korišćenje alata za kapaljku i alata za četkicu za uzorkovanje i nanošenje 

boja na paletu

• Uzorkovanje ističu, srednjih tonova i senki iz prosečnih referentnih područja

• Skrivanje referentne slike da se fokusira na bojenje ciljnu sliku

• Sloj za podešavanje gradijentne mape se dodaje i stavlja ispod palete

• Mapiranje gradijentnih boja: senka za tamnu, srednji ton za srednju, vrhunac 

za svetlost

• Mapa gradijenta mora biti izabrana direktno (ne maska) da bi se omogućilo 

uzorkovanje boja

• Promena režima mešanja gradijentne mape u boju da efikasno primenjuju 

tonove



Slikanje i mešanje tonova kože
• Odabir maske sloja i obrnuto (Ctrl / Cmd + I) da sakrijete efekat

• Korišćenje alata za četkicu sa mekom tvrdoćom i umerenom veličinom za ručno 

otkrivanje tonova kože

• Podešavanje protoka četkice ili neprozirnosti u zavisnosti od željene suptilnosti 

ili zahteva slike

• Izbegavanje određenih područja kao što su usne i kosa za ciljani tretman boja 

kasnije

• Korišćenje Ks tastera za prebacivanje četkom između boje i brisanja dok 

rafiniranje ivice

• Primena mešanja podešavanja preko Blend If opcija u Stilovima slojeva za 

preciziranje tonskih prelaza

• Podešavanje tamnih i svetlih klizača kako bi se osiguralo da se boja prirodno 

uklapa sa osnovnim tonovima kože



Poboljšanje kose, odeće i usana
• Dodavanje sloja za podešavanje nijanse / zasićenja; aktiviranje Colorize da 

primenite ton

• Okretanje maske (Ctrl / Cmd + I) i selektivno slikanje preko kose ili odeće kako 

bi se otkrila boja

• Korišćenje četkica sa niskim neprozirnim faktorima za nanošenje suptilnih 

tonova i simulaciju realnih naglasaka

• Isprobavanje različitih modova mešanja kao što je boja za poboljšanje 

integracije tonova

• Nanošenje boje na odevne površine koristeći isti sloj i metod za konzistentnost

• Za usne, stvarajući novi sloj, koristeći crveni ton sa niskim protokom (25%) i 

pažljivo obojite

• Podešavanje režima mešanja sloja boja usana na boju i fino podešavanje 

neprozirnosti
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